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1 - About This Manual
Conventions Used in This Manual
1 About This Manual

Purpose of This
Chapter

This chapter points out the purpose of the manual, specifies the product the 
manual deals with and who the manual is intended for. Furthermore, it explains 
the symbols, conventions and abbreviations used and offers other general 
information.

 

Purpose of This
Manual

This manual describes the Run Control (GUI) of Freedom EVOlution SW. The 
Run Control is a part of the complete software, which is used to control liquid 
handling and processes.

The information given in this manual is based on the assumption that

 Freedom EVOlution SW is properly installed.
 users with the corresponding access rights are set up by the system 

administrator.
 the instrument is configured according to the process to be run.
 the processes to be run are tested and validated.

Target Group This manual is intended for operators, e.g. laboratory technicians, who run scripts 
or processes on the Tecan automation platforms.
It provides guidance to operators on how to start, operate and close the Freedom 
EVOlution Run Control.
The Manual only describes the dialogs of the software that are accessible on 
operator level. It does not enable the user to define or modify scripts or processes.

Note: For application specialists a comprehensive Software Manual exists.

Scope This manual applies to the Run Control of Freedom EVOlution SW version 2.0 
and 2.1.

For Your Safety Before installing and running the Freedom EVOlution SW, first read the 
Runtime Controller Manual carefully, in particular chapter 2 “Safety”.

 

1.1 Conventions Used in This Manual

 Cross-references appear as follows: e.g. “Refer to section “1.1.1  1-1“
– 1.1.1 refers to the corresponding chapter number
– The symbol  denotes “page number”
– 1-1 refers to the page number, whereas the first number stands for the 

chapter number (chapter 1 page 1)

Note: The symbols pertaining to safety (WARNINGS and ATTENTIONS) are 
explained in chapter 2 “Safety”,  2-1.
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Reference Documents
1.2 Reference Documents

This section provides a list of documents which are needed or may be useful in 
connection with the Freedom EVOlution Run Control.

What Does the
Doc. ID Tell

You?

The Doc. IDs listed below are root numbers. Therefore, they do not contain 
information about the language, document version or the medium (data storage 
medium, hardcopy, downloadable file, etc.) of the document.
Check the scope of the corresponding document to make sure that you are in 
possession of the correct version.

Note: The Doc. ID does not represent ordering information. For orders refer to the 
number on the binder, CD casing, etc.

 

Operating
Manuals

 Freedom EVOlyzer Operating Manual (Doc ID 393035)
 Freedom EVO Clinical Operating Manual (Doc ID 393062)

1.3 Trademarks

The following product names and any registered and unregistered trademarks 
mentioned in this manual are used for identification purposes only and remain the 
exclusive property of their respective owners:

 Freedom EVOlutionTM is a trademark of Tecan Group Ltd.
 Freedom EVOlyzer® and Freedom EVO® are in major countries registered 

trademarks of Tecan Group Ltd.
 Windows® is a registered trademark of Microsoft Corporation.
 Codesoft® is a registered trademark of Braton Groupe sarl.

1.4 Abbreviations

ASTM
American Society for Testing and Materials. The ISO organization which 
defined a serial transmission protocol for laboratory data

ELISA
Enzyme-Linked Immunosorbent Assay

GUI
Graphic User Interface

LIMS
Laboratory Information System

SW
Software
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User Qualification
2 Safety

Purpose of This
Chapter

This chapter covers only the general introductory safety instructions applicable to 
the Freedom EVOlution SW. Specific safety instructions of the hardware devices 
are laid down in the respective hardware manuals.

 

Significance of
These Safety
Instructions

The Freedom EVOlution SW is a pure software product and as such it does not 
contain any hazardous parts. However, the software is used to control hardware 
devices and options, which may contain parts that can move with great force and 
at considerable speed.
As a consequence, the safety of users and personnel can only be ensured if the 
safety instructions in this Runtime Controller Manual as well as the safety 
instructions of the hardware devices controlled with the software described here 
are strictly observed and followed.
Therefore, all relevant manuals must always be available to all users working with 
the Freedom EVOlution SW.

 

2.1 User Qualification

What Users
Must Know

Users must be qualified and trained to run the Freedom EVOlution SW.

In particular, they must fulfill the following qualifications:

 They must have a basic knowledge of the Windows operating system.
 They must have a thorough knowledge of the processes run on the system.
 They must be familiar with the “Good Laboratory Practice” guidelines.
 They must have read and understood the instructions in this Runtime 

Controller Manual.

Only users that meet the qualifications prescribed here are authorized to run the 
program described in this Runtime Controller Manual.

Training
Courses

Note: Tecan recommends that users attend a software training course. Please 
ask your nearest Tecan representative about the available courses.
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Warning Notices Used in the Manuals
2.2 Warning Notices Used in the Manuals

The symbols used for safety-related notices have the following significance:

WARNING
Symbols

WARNING notices appear as follows:

WARNING

Generally, the triangular warning symbol indicates the possibility of personal injury 
or even loss of life if the instructions are not followed.

 

ATTENTION
Symbols

ATTENTION notes appear as follows:

ATTENTION

With the general “Read This!” symbol, ATTENTIONs indicate the possibility of 
equipment damage, malfunctions or incorrect process results, if instructions are 
not followed.

 

2.3 Use of the Software

Intended Use The Freedom EVOlution Run Control is used to run processes that perform

 pre-analytical sample distribution and assay preparation on a Tecan Freedom 
EVO Clinical instrument.

 ELISA and similar tests on a Tecan Freedom EVOlyzer instrument.

Refer to the comprehensive Software Manual of your software installation.
The software must not be used for applications other than listed there.
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Safety of the Overall System
2.4 Safety of the Overall System

In addition to the safety instructions in this Runtime Controller Manual, the safety 
instructions in the manuals of the hardware devices must also be observed and 
followed.

WARNING

Hazards originating from the hardware devices controlled with this software.
Mind the safety instructions of all instruments and options which are used in 
connection with the Freedom EVOlution SW.

 

2.5 General Safety Rules

Legal
Regulations

Legal regulations, such as local, state and federal laws which prescribe the use or 
application as well as the handling of dangerous materials in connection with the 
Freedom EVOlution SW must be strictly followed.

Modifications Modifications to the Freedom EVOlution SW are not permitted. The manufacturer 
will decline any claim resulting from unauthorized modifications.
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3 - Starting the Freedom EVOlution SW
Freedom EVOlution Run Control
3 Starting the Freedom EVOlution SW

Purpose of This
Chapter

This chapter describes how to start the Run Control of Freedom EVOlution SW on 
the corresponding operator level.

3.1 Freedom EVOlution Run Control

The Freedom EVOlution Run Control for the routine operation of the Freedom 
EVOlution SW can be operated via a touchscreen.
Start the Freedom EVOlution Run Control from the Windows start menu.

3.1.1 Access Rights

The following table gives an overview over the user groups and their 
corresponding access rights.

3.1.2 Operating Elements of the Run Control

Tab. 3-1 Access rights

User group Access right

Lab operator Start Run, Maintenance

Application Specialist Start Run, Maintenance, Application Settings

Administrator Start Run, Maintenance, Application Settings, User Management

Button Button Name Description

Next Saves the settings of the current dialog box and brings 
you to the next step of the operating procedure.
Starts a certain procedure, e.g. an instrument flush.

Stop Aborts the operating step currently in progress.

Main menu Brings you back to the main menu.

Add user Clears fields for user name and full name located on the 
left-hand in order to add a new user.

Back Returns to the Load consumables dialog in case of an 
error message.
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3 - Starting the Freedom EVOlution SW
Freedom EVOlution Run Control
Cancel/No Replies with No.

Commit/Apply/
Done/Yes/OK

Confirms that the required step was carried out success-
fully.
Replies with Yes.

Exit Exits the program.

Missing sam-
ples

Displays a list of samples missing on the worktable. The 
list can be printed.

Modify Returns to the Sample work orders dialog.

Print Displays the available information and offers the possibil-
ity to print it.

Retry Retries the current procedure, e.g. reconnect to the 
instrument.

Repeat Repeats the current procedure, e.g. a flushing procedure.

Save Saves changes.

Save barcode Saves the entered barcode.

Scan samples Initiates a sample scan.

Skip Skips the currently required maintenance step and pro-
ceeds to the next one.

Strip Frame Displays the layout of every single strip frame.

Carrier Returns to the Load plate view.
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Freedom EVOlution Run Control
3.1.3 Login

To log in, proceed as follows:

1 Type in your user name in the first row.

2 Type in your password in the second row.

Note: If you log in for the first time, your password is the same as your user name. 
Ask your administrator, who carried out the software setup, for the user name he 
created for you.

3 Click the Next button to log in.

You will get to the main menu.

Update Applies changes.

View records Displays the maintenance records.

View schedule Displays the current state and course of the run progress.

View time Displays time until completion of the run.

Fig. 3-1 Login dialog box
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Freedom EVOlution Run Control
3.1.3.1 New Password Required

Note: If you log in for the first time or if your password has expired (Default 
setting: After 90 days), the Login dialog box will switch into “Change Password 
mode”.

In this case enter the new password in the corresponding field, confirm it and click 
the Next button to log in.

Note: The new password must differ from the old one.

In case the entered user name or password was wrong a corresponding error 
message is displayed.
Confirm the error message with OK and retry to log in.

Note: If you enter a wrong password three times in a row, you are not able to log 
in anymore. In this case, contact your administrator for assistance.

To close the Login dialog box of the Freedom EVOlution Run Control and thus to 
shut down the software program, click the Cancel button.

To display the current software version and additional information click the About 
button. The About dialog box opens (not shown here). This dialog box supplies 
the following information:
 Current program version
 Manufacturer name
 Copyright information.

Click the OK button to close the dialog box.

Fig. 3-2 Login dialog box
3 - 4 Freedom EVOlution SW Runtime Controller Manual, 394803, en, V2.3



3 - Starting the Freedom EVOlution SW
Main Menu
3.2 Main Menu

Before the main menu is displayed, the system checks, whether a printer is 
connected and whether configurations are available on the computer. 
If no printer is found, a corresponding message is displayed. Click the OK button 
to confirm the message. You can continue your routine operation but no reports 
can be printed out.
If no configuration is found on the computer, a corresponding message is 
displayed. Confirm the message by clicking the OK button. The Freedom 
EVOlution Run Control is closed.

Fig. 3-3 Main menu dialog box
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Main Menu
The main menu enables access to four submenus in which you can carry out the 
following tasks:

 Activate the corresponding option button and click the Next button to get to 
the desired submenu. 

 To close the program click the Exit button.

Submenu Action Reference

Start Run To start runs (for operators, application spe-
cialists and administrators)

See section 
4.1,  4-1

Maintenance To carry out the daily and weekly mainte-
nance and print out maintenance reports 
(for operators, application specialists and 
administrators). If “(overdue)” is indicated 
behind the submenu, at least one mainte-
nance task of one of the maintenance 
sequences is overdue.

See section 
5.1,  5-1

Application Settings To set up the application settings (for appli-
cation specialists and administrators)

See section 
4.2,  4-31

User Management To add users and define their access rights 
(for administrators only)

See section 
4.3,  4-37
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Main Menu
3.2.1 Safety Concept

The Freedom EVOlution Run Control is operated according to a safety concept in 
conformity with regulatory requirements.
This concept provides an authentication prior to each task accessible from the 
main menu. As soon as you have selected a submenu from the main menu and 
click the Next button, the Authenticate dialog box opens:

To authenticate, proceed as follows:

1 Type in your user name in the first row

2 Type in your password in the second row

3 Click the Next button.

You will get to the desired submenu of the main menu.

To get back to the main menu click Main menu.

Fig. 3-4 Authenticate dialog box
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Main Menu
3.2.1.1 Changing Password

To change your password, activate the check box Change password and click 
the Next button. The Change password dialog box appears:

To change the password, proceed as follows:

1 Type in your user name in the first row.

2 Type in your current password in the second row.

3 Type in your new password in the third row.

Note: The password must consist of at least 5 and not more than 32 
alphanumerical or numerical characters.

4 Confirm your new password in the fourth row.

5 Click the Next button.

You will get to the desired submenu of the main menu.

To get back to the main menu click Main menu.

Fig. 3-5 Change password dialog box
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Setting Language
3.3 Setting Language

The Freedom EVOlution Run Control supports several user languages. The 
language is defined during the specific language setup.

If you would like to change the language setting later on without installing the 
software new, proceed as follows:

1 Direct the mouse cursor to Freedom EVOlution Software via 
Start>Programs>[Path] but do not open the file.

2 Call up the context menu (e.g. with right mouse button).

3 Click on Properties.

4 In the Target command line, enter the two-character language code of the 
language group according to ISO 639 (e.g. en for English), followed by the 
code of the language subgroup (e.g. EN) as shown in the example. Note that 
the second language code must be entered in capital letters.

Note: In the above example “en” represents the language group, whereas “EN” 
represents the required country-specific language, i.e. the required type of English 
(British, American, South African English etc.).

• If the language is supported, Run Control will change to that language when 
the software is started.

• Otherwise, the software will switch to the default English language.

The following table gives examples for the language codes:

"***.exe" "en-EN"

Tab. 3-2 Examples for language codes

ISO 639 Code Subgroup (e.g. dialect)a)

a) Microsoft standard for Culture Name, also see Language ReadMe file

Represented language

en EN English, Great Britain

de DE German, Germany

fr FR French, France

it IT Italian, Italy

es ES Spanish, Spain

pt PT Portuguese, Portugal

sv SE Swedish, Sweden

ru RU Russian, Russia

zh CN Chinese, China

nb NO Norwegian, Norway
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3.4 Exiting Freedom EVOlution SW

Click on the red cross in the upper right edge of the startup wizard or on the 
Cancel button.
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4 Running a Process

Purpose of This
Chapter

This chapter describes the preparatory steps before a process run and how to run 
the process in the corresponding work mode.

4.1 Start Run

If you have selected start run and a maintenance task is overdue, the following 
dialog box will open:

The dialog box shows you a warning message, that you are trying to start a run 
while at least one maintenance task is overdue.
If you click the No button you will get back to the main menu from which you can 
access your overdue maintenance task (see section 3.2 “Main Menu”,  3-5).
If you click the Yes button you will get to the Select configuration dialog boxes, 
i.e. proceed with the preparation for a new run without carrying out maintenance. 
The results of this run will therefore be flagged with a warning indicator.

Fig. 4-1 Maintenance overdue warning dialog box
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Note: EVOlution 2.0 has no Sample Splitting selection.

1 Click on the arrow next to the drop-down list Configuration and highlight the 
desired item to select the configuration you want to work with.

2 Select the desired profile from the drop-down list Profile.

The list in the field Tests shows all associated tests in the current profile 
within the selected configuration.
Refer to the Freedom EVOlution SW Application Software Manual.

3 If you have selected the work mode “Batch” on the Main Settings tab of the 
Application Settings menu, or when working in the Load and Go mode for 
Sample Splitting, you can select which tests of the configuration should be 
carried out for each sample by activating the check box in front of the test/ 
workgroups name. 

For further information refer to: 4.1.5 “Sequence and Work Modes”,  4-7

4 Click the Next button.

You will get to the loading dialog boxes.

To get back to the main menu click Main menu.

Note: In case you have selected a configuration, which has not been signed, yet, 
a corresponding message will be displayed by the software. To confirm this 
message, click the OK button. The data resulting from the run carried out with an 
unsigned configuration are flagged.

Note: In case you are working with worklists and no worklist can be found on the 
computer, a corresponding message is displayed. Confirm this message by 
clicking the OK button.

Fig. 4-2 Select configuration dialog box
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Note: When the software cannot connect to the instrument, a corresponding error 
message is displayed. Try to fix the problem by checking the instrument status 
and the cable connections and then click the Retry button or click the Cancel 
button to get back to the main menu.

4.1.1 Initializing

In the following sequence the instrument will be initialized. The initialization 
process is visualized by means of different dialog boxes.
Each dialog box displays the instrument part currently initialized and indicates the 
initialization status by means of a progress bar.
When an instrument part was initialized successfully, the program automatically 
switches to the next dialog box.
At the beginning of the sequence you are prompted to remove all non-required 
components from the worktable.

When you have performed this task tick the check box to confirm and click the 
Next button to proceed.

First, the arm(s) will be initialized and the following dialog box appears:

Note: If the arm is already initialized and in its correct position this dialog box 
does not appear, i.e. this step is omitted.

Fig. 4-3 Check the worktable for plates dialog box
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EVOlyzer
Platform Only

Move the arm(s) to the center of the instrument, so that they can be properly 
initialized and click the Next button to proceed.

In case an error occurs during initialization, a corresponding error message with 
problem description and recovery is displayed.

Note: For more information on the error message refer to the tables in chapter 
7 “Error Handling”,  7-1.

Try to fix the problem at the instrument and select an option from the option box 
by activating the corresponding check box. Then click the Next button to proceed 
as selected.

4.1.2 Customized Startup Steps

Note: If you have defined one or several customized startup steps in the 
corresponding configurator, they will be carried out after the instrument 
initialization (for more details on the usage and creation of customized startup 
steps, please refer to the Freedom EVOlution SW Application Software Manual).

When you have finished with your customized startup step(s), click the Next 
button to proceed.

Fig. 4-4 Arms will be initialized dialog box
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4.1.3 Checking for Plates

EVOlyzer
Platform Only

You are prompted to remove the plate(s) from the device(s) (e.g. Sunrise reader).

Note: This dialog box only appears if such a device is installed on the instrument.

When you have performed this task tick the check box to confirm and click the 
Next button to proceed.

Fig. 4-5 Check device for plates dialog box
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4.1.4 Checking DiTis

If you are operating with DiTis, you are now prompted to check the DiTi waste 
bag.

When the DiTi waste bag is empty, click the Next button to proceed.
You are now prompted to load the consumables needed for the test in your 
selected configuration on the worktable. The status lamp of the instrument is 
flashing green. To abort the preparation of the run and get back to the main menu, 
click Main menu.

WARNING

Pipetting tips can cause injuries.
 Avoid contact with the pipetting tips and contact with aerosols when accessing 

the worktable, by wearing adequate protective clothing.

Fig. 4-6 DiTi waste bag dialog box
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4.1.5 Sequence and Work Modes

Standard Work Mode

 Worklist (or ASTM):
– If the work mode in the tab Main Settings in the Application Settings is 

set to worklist mode, the operator can check and/or update the worklist 
before processing. A worklist file must be present in the folder “Worklist”. 
The selection of the tests in the Select Configuration panel is not 
possible, because the assignments are defined in the worklist.

 Batch:
– If the work mode in the tab Main Settings in the Application Settings is 

set to batch mode, the operator needs to select which tests of the 
configuration must be carried out for each sample. The operator can 
check and/or update the work order before processing.

Loading mode1)

 Normal Loading:
– The operator is enabled to load the consumables or plates during the 

initial load procedure.
 Shopping List Loading:

– The system performs the loading procedure. The operator needs to load 
all items displayed in the loading panels.

Sample Splitting Work Mode1)

 Load and Go
– The operator loads the sample sections and workgroups, samples as well 

as secondary tubes. The system automatically scans the worktable for the 
operator to edit the work orders in the samples work order panel.

Note: When the Load and Go mode has been selected, the system operates in 
batch mode disabling all other work mode functions.

 Scan and Load
– The system scans the samples. The operator is asked to assign the 

workgroups to the samples. The software provides a file with the barcode 
list to be used with an external barcode printing software. The operator 
applies the labelled secondary tubes onto the workgroups.

Note: When the Scan and Load mode has been selected, the system operates in 
worklist mode disabling all other work mode functions.

Order of Dialog
Boxes

Note: The different modes result in the dialog boxes, particularly the flush, 
scanning, load consumables, load wash buffers and load plates dialog boxes, 
being displayed in different order, depending on the selected work and loading 
mode. The general steps, however, are identical.

Example for a Shopping List Loading (order may change):

1 Load samples

2 Scanning

1) This setting is made by the application specialist in the Application Settings Control
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3 Sample work orders

4 Shopping list summary

5 Load wash buffers1)

6 If specified in the reader method: Enter assay-specific variables1)

7 Load consumables

8 Flushing liquid system and prime washer1)

9 Load plates

The following dialog boxes prompt you to load the corresponding consumables 
onto the worktable and to select the required items:
 Shopping List Summary (Shopping List Loading only)
 Plates
 Wash buffers1)

 Consumables
 Waste and system liquid

Always follow the instructions provided on the screen. For more information refer 
to the explanations given after the subsequent sequence of dialog boxes.
This dialog box is only displayed in Shopping List Loading mode and lists the 
consumables that are needed for the test.

Note: Item list: Black text refers to items that need to loaded immediately (Initial 
loading); red text refers to items that will be requested later (during the run).

1) EVOlyzer platform only

Fig. 4-7 Shopping List Summary dialog box
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To print the shopping list, click the Print button.
The appearing print preview is similar to the one in Fig. 4-15 “Print preview of 
Consumable Report”,  4-16.

To return to the sample work orders dialog, click the Modify button.

Click the Next button to proceed.

4.1.6 Loading Plates

EVOlyzer
Platform Only

The dialog box below prompts you to load the plates. For more information see 
later in this section.

Note: A graphical presentation of the consumable facilitates its identification. 
Click on the list item to highlight the corresponding graphical presentation. When 
you click on the presentation, the list item will be highlighted.

Note: The barcode ID entry field and the Update button (to apply the barcode ID 
entry) are only enabled if the Edit Barcode mode is enabled.1)

Click Strip Frame to view the layout of every single strip frame.
Click the Next button to proceed.

Fig. 4-8 Load plates dialog box

1) This setting is made by the application specialist in the Application Settings Control
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Fig. 4-9 Load strip frames dialog box
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4.1.7 Loading Wash Buffers

EVOlyzer
Platform Only

Next, you are prompted to load the wash buffers. For more information see later in 
this section.

Note: A graphical presentation of the consumable facilitates its identification. 
Click on the list item to highlight the corresponding graphical presentation. When 
you click on the presentation, the list item will be highlighted.

Click the Next button to proceed.

Fig. 4-10 Load wash buffers dialog box
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4.1.8 Loading Consumables

Next you are prompted to load the consumables. For more information see later in 
this section.

Note: A graphical presentation of the consumable facilitates its identification. 
Click on the list item to highlight the corresponding graphical presentation. When 
you click on the presentation, the list item will be highlighted.

Loading
Microplates

Note: The Barcode ID entry field and the Update button (to apply the barcode ID 
entry) are only enabled if the Edit Barcode mode is enabled1).

Click the Next button to proceed.

After you have made the required entries you are prompted to load the waste 
liquid container and the system liquid container. For more information see later in 
this section.

Fig. 4-11 Load consumables dialog box: Load microplates

1) This setting is made by the application specialist in the Application Settings Control
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Loading Liquid
Containers

Click the Next button to proceed.

Loading
Reagents and

Controls

When you are prompted to load reagents and controls, the corresponding dialog 
box appears, depending on the setting of Volume Pre Checking (enabled/
disabled).

Note: When Volume Pre Checking is enabled, the instrument checks the 
currently available volume of the consumables on the worktable. The system 
compares the available quantity with the required quantity. If the available quantity 
is insufficient the user is requested to refill the consumable.

This option is set in the “Consumables Data Editor”.

Shopping List
Mode

The Shopping Liste Mode provides the activation of optional consumables 
during initial load if enabled1).
The following options are available:
 Initially select optional consumables
 Perform volume check for optionally loaded consumables during initial load

Fig. 4-12 Load consumables dialog box: Load waste and system liquid containers

1) This setting is made by the application specialist in the Application Settings Control
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If Volume Pre Checking is disabled the dialog box appears as follows:

Fig. 4-13 Load consumables dialog box:
Load reagents and controls (with volume pre checking)

Fig. 4-14 Load consumables dialog box:
Load reagents and controls (without volume pre checking)
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Click the Next button to proceed.

Explanations

The tabs Common or Typical reagent contain an Item list that shows the 
consumables to select or deselect.

 Select the required item(s) from the list 
 Items that are not needed for a test can be deselected by clearing the 

corresponding check box(es).
 You can also select/deselect all items in the list by selecting or clearing the 

check box Select/Deselect All below the list.

Note: If you deselect an item, although it is needed during the run, a reload 
procedure has to be carried out for that item.

 If you highlight an item in the list, additional information on that item is 
provided on the right side of the screen.

 When you have loaded all consumables necessary for your run on the 
worktable, click the Next button to proceed.

 To abort the run preparation and get back to the main menu, click Main menu.
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To print a list of the consumables with their corresponding specifications, click 
Print in the corresponding dialog box.
The figure shows an example for a print preview as it may appear:

4.1.9 Scanning

The instrument now starts to scan the items on the worktable.
In the corresponding dialog box, the scanning status is indicated by means of a 
progress bar.

In case an error occurs during scanning, a corresponding error dialog box is 
displayed, indicating the expected and the actual situation.
For reagents and plates the error handling corresponds to the procedure 
“Scanning of Samples” (see section 4.1.13,  4-19).

Note: For more information on the error message refer to the tables in chapter 
7 “Error Handling”,  7-1.

The signal lamp and the LED on the loading interface at the corresponding grid 
position are flashing red. Try to fix the problem at the instrument by accessing the 
grid position with the flashing LED (indicated in the item list). 
Then click the Next button to proceed and repeat the scanning procedure or click 
Cancel to abort the run preparation.

Fig. 4-15 Print preview of Consumable Report
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4.1.10 Flushing

After the scanning procedure is finished successfully, the instrument starts 
flushing the liquid system.
In the corresponding dialog box, the flushing status is indicated by means of a 
progress bar.

When the flush is completed, the corresponding dialog box is displayed:

You are now prompted to check the tubing for bubbles. If there are still bubbles 
present in the tubing, click Repeat to repeat the flushing process.
When the tubing is free of bubbles, click the Next button to continue.

4.1.11 Heating

EVOlyzer
Platform Only

Now the heated incubators are heated to their operating temperature.
The expected completion time is displayed in the corresponding dialog box.

Fig. 4-16 Flushing completed dialog box
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4.1.12 Loading Samples

WARNING

Pipetting tips can cause injuries.
 Avoid contact with the pipetting tips and contact with aerosols when accessing 

the worktable, by wearing adequate protective clothing.

ATTENTION

Loading samples before system is initialized may cause collision with tips.

Note: The sections available for samples are indicated with a green LED at the 
corresponding grid position on the loading interface.

When you have loaded all consumables necessary for your process on the 
worktable, click the Next button to proceed.

Fig. 4-17 Load samples dialog box
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4.1.13 Scanning the Samples

The samples will now be scanned.
To abort the run preparation and get back to the main menu, click Main menu.

Note: The user is responsible for the correct worktable layout as defined in the 
software, i.e. the defined racks with the correct sample assignment must be 
present on the worktable.

In case an error occurs during scanning, a corresponding error message is 
displayed, indicating the grid position, the position in the rack and the reason for 
the error.

Now you can select one of two possibilities to continue by activating the 
corresponding option button.

 Access carrier(s) and fix the problem: When this option button is activated 
and you click the Next button, the status lamp starts flashing red, the acoustic 
alarm sounds and the Access worktable dialog box is displayed (see Fig. 4-
19,  4-20).

 Ignore these samples and continue: When this option button is activated 
and you click the Next button, the run preparation will be continued and the 
samples affected by the error will be ignored.

To get back to the Scan report dialog box, click the Cancel button.

Fig. 4-18 Scan report dialog box
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4.1.13.1 Access Worktable

To fix the problem, access the worktable and proceed as indicated on the Access 
worktable dialog box.

Note: You only have a certain time slot to access the worktable. Afterwards the 
PosID will repeat the scanning procedure.

As soon as you click on one of the lines in the table on the right, the entry fields on 
the left and the Save barcode button become active.

Now proceed as follows:

1 Enter the barcode value for the line you clicked on in the upper field.

2 Optional: Confirm it in the lower field (depending on the settings of the 
barcode entry options)1).

3 Click Save barcode.

4 Proceed like this for all barcodes in the table. 

5 When you have finished, click the Next button.

Fig. 4-19 Access worktable dialog box

1) This setting is made by the application specialist in the Application Settings Control
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4.1.14 Work Order Assignment

After the samples have been scanned, you can make changes to the work order 
assignments.
Work mode views can be changed in the Workmode view drop down list Fig. 4-
20,  4-21, Fig. 4-21,  4-22.

Standard Work Mode View

If the system is operating in worklist or ASTM mode, the user can edit the 
requests for each sample. If it is operating in batch mode the user can assign all 
previously selected tests to all samples.

All samples found are listed with their grid position, their position on the carrier 
and their barcode in the area on the right. By using the Filter function, you can 
assign the samples to the corresponding test(s) by marking a line with the sample 
ID and selecting the check box of the test.

The samples for which an assignment was modified are marked red.

 Click the Update button (only visible if changes are made) to accept the 
changes.

 Click the Next button to proceed with the selected option.

Note: If dilution factors are selected, the factors are displayed (value in brackets 
after the test name).

For details on dilution factors refer to the Freedom EVOlution SW Application 
Software Manual.

Fig. 4-20 Sample workorders dialog box, Standard
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Sample Splitting Work Mode View

If the system is operating in Scan and Load mode, the user can edit the requests 
for each sample. If it is operating in Load and Go mode the user can assign all 
previously selected workgroup to all samples.

All samples found are listed with their grid position, their position on the carrier 
and their barcode in the area on the right. By using the Filter function, you can 
assign the samples to the corresponding workgroup(s) by marking a line with the 
sample ID and selecting the check box of the test.

The samples for which an assignment was modified are marked red.

 Click the Update button (only visible if changes are made) to accept the 
changes.

 Click the Next button to proceed with the selected option.

Fig. 4-21 Sample workorders dialog box, Sample Splitting
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Note: The screen Load secondary tubes is only displayed in the Scan and 
Load mode Fig. 4-22,  4-23.

Print button
Print preview and print 

Save button
Freedom EVOlution SW compiles several files format (csv, txt, csd) of which

barcodes can be printed with a third party software such as CodeSoft etc.

The storage location and file format to generate reports and barcodes have to 
be defined in the Application Settings Control.

ATTENTION

Risk of malfunctions. Not loaded tubes will lead to malfunctions. 
 Make sure tubes have been loaded.

1 Confirm the loading of the tubes by ticking the ckech box I confirm I have 
loaded all tubes.

2 Click the Print button to generate the report.

Fig. 4-22 Load Secondary Tubes dialog box
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4.1.15 Transferring Plate

EVOlyzer
Platform Only

In Shopping List Mode the RoMa transfers the plate from the loading port (or RT 
incubator) to the shelf.

After completing all processes this dialog box appears again to inform that the 
RoMa returns the plates from the shelf to the loading port.

If an error occurs during plate transfer, a corresponding error dialog box appears.

Note: For more information on the error message refer to the tables in chapter 
7 “Error Handling”,  7-1.

Rectify the error and click the Next button to proceed.

Fig. 4-23 Transferring Plate dialog box
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4.1.16 Schedule

4.1.16.1 Calculating the Schedule

When the instrument is ready to start the run, the time to completion and the 
schedule will be calculated.
When this procedure is finished, the following dialog box is displayed:

The time to completion in hours, minutes and seconds elapsing is visualized in the 
center of the dialog box.

To print a list of current ticker messages, click Print Message(s).

To visualize the current state and course of the run progress, click View 
schedule.

Fig. 4-24 Run in progress dialog box
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On the y-axis the tests currently running for each plate as well as reload and scan 
information are applied. Each colored bar represents the instrument actions 
carried out for one plate. The x-axis is a time axis, showing how much time will be 
needed for each instrument action. The meaning of the colors is explained in the 
legend in the lower part of the dialog box.
The narrow blue upright bar shows the state the instrument is currently in.
The narrow red line shows that a new schedule is in progress.
The table at the bottom of the dialog box shows a list of scheduled reload 
procedures (“Message”) and indicates the “Time”, the message was reported. The 
schedule computation is carried out continuously, so that the messages are 
updated in regular intervals and listed below the last reported message.
When a job is finished, it will disappear from the schedule dialog box.

To get back to the previous dialog box showing the time to completion, click the 
Next button.

ATTENTION

Possible instrument malfunction and arm crashes into labware.
 Never pull a carrier during a run when the corresponding position of the 

loading interface LED is red, nor place any carrier on an empty grid position 
when the corresponding red LED is lit.

 By moving carriers on the worktable without permission, they might end up in 
the planned trajectories of other moving devices and thereby cause a crash.

 The instrument will display a warning if a carrier is moved on the worktable in 
such a situation.

Fig. 4-25  Current schedule dialog box
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When you want to reload samples on your worktable during the continuous 
loading process, position the samples on the worktable, where the lit green LED 
on the loading interface indicates access and click Scan samples.

Clicking the Stop button in the lower left corner will abort the run.

4.1.16.2 Reload

Before you run out of reagents for a certain test or when critical consumables 
have already remained too long on the worktable, a reload announcement is 
displayed.
Reload processes are also scheduled and displayed in the scheduler.

On the appearing dialog box, the test for which a reload is needed is displayed 
with the item list and the corresponding item to be reloaded.
In the upper right corner, the time for which the reload is scheduled is displayed.

The table at the bottom of the dialog box shows a list of scheduled reload 
procedures (“Message”) and indicates the “Time”, the message was reported. The 
schedule computation is carried out continuously, so that the messages are 
updated in regular intervals and listed below the last reported message.

To print a list of the items to be reloaded, click the Print button.

Click the Next button to get back to the previous dialog box showing the time to 
completion or the current schedule.

When the reload actually needs to be carried out, the status lamp of the 
instrument is flashing green and the Load consumables dialog box appears:

Fig. 4-26 Reload announcement dialog box
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You are now prompted to load the consumables needed to continue your current 
test on the worktable.

WARNING

Pipetting tips can cause injuries.
 Avoid contact with the pipetting tips and contact with aerosols when accessing 

the worktable, by wearing adequate protective clothing.

ATTENTION

Time-critical operation.
 Make sure to reload the item within the scheduled time, otherwise the 

corresponding test will be aborted.

The appearing dialog box lists the test(s) for which a consumable has to be 
reloaded. The corresponding consumable(s) is/are displayed in the item list. 
Information on the currently highlighted item is given on the right. 
The placement instructions tell you exactly where to put the corresponding 
consumable on the worktable. The text on the left indicates the time you have for 
the reload.

To print a list of the consumables to be reloaded with their corresponding 
information, click the Print button.

Fig. 4-27 Load consumables dialog box
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The appearing print preview is similar to the one in Fig. 4-15 “Print preview of 
Consumable Report”,  4-16.

When you have loaded all consumables necessary for the completion of your run 
on the worktable, click the Next button to get back to the previous dialog box 
showing the time to completion.
To abort the run preparation and get back to the main menu, click the Cancel 
button.

4.1.17 Completing the Process

When all processes are completed the following dialog box is displayed:

The instrument is now waiting for new samples to be loaded. In order to start new 
processes, load the samples in the available sample sections on the worktable, 
where the green LEDs on the loading interface are lit to indicate access.
 Click Scan Samples when done.
 If no more samples are to be processed, click the Stop button.

4.1.17.1 Shopping List Mode

In shopping list mode, when the Stop button is clicked:
 You are now asked to unload the plates from the shelf or the microplate 

carrier. For each plate, the position and barcode, as well as the completion 
status and the number of available wells (if the plate has been defined for 

Fig. 4-28 Scheduled processes completed dialog box
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reuse) are displayed. To print a list of all plates with their corresponding status, 
click the Print button.
– When you have unloaded all required plates, click the Next button to 

proceed.
– To abort the plate unload and get back to the main menu, click Main 

menu.

4.1.17.2 Run Finished

The run is now finished and the following dialog box is displayed:

Click the Next button to get back to the main menu, or, if you have defined one or 
several customized shutdown steps in the corresponding configurator, they will be 
carried out now (for more details on the usage and creation of customized 
shutdown steps, please refer to the Freedom EVOlution SW Application Software 
Manual.
When you have finished with your customized shutdown step(s), click the Next 
button or Main menu to get back to the main menu.

Fig. 4-29 Run is finished dialog box
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4.2 Application Settings

Note: This submenu is accessible for Application Specialists and Administrators 
only.

The submenu Application Settings consists of a dialog box with five different tabs:

 Main settings
 Barcode types
 Paths
 Report options
 Persistence

To open these dialog boxes, click the corresponding tabs.

Note: Further settings can be made in the Application Settings Control:
Refer to the Freedom EVOlution SW Application Software Manual.

4.2.1 Main Settings

On the Main settings tab you can define some general run parameters.
Configuration: Here you can select a configuration by clicking the arrow next to 
the corresponding field. A drop-down list with all configurations opens. Highlight 
the configuration you want to work with by clicking on it.
Profile: Select the desired profile. A profile associates a set of assays within a 
configuration. According to the profile, the placement of the consumables on the 
worktable will be affected.

Fig. 4-30 Main settings dialog box
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Workmode: Three different workmodes are available:

 Batch: When this work mode is selected, all samples on the worktable are 
processed with the tests activated under Tests.

 Worklist: When this work mode is selected, the samples on the worktable are 
processed according to a worklist created with the Worklist Creator (see 
section 6.3 “Worklist Creator”,  6-6 for details). The corresponding worklist 
must be saved in the folder specified on the Paths tab.

 ASTM: When this work mode is selected, the information concerning the tests 
to be carried out with the samples on the worktable are inquired from the 
connected LIMS.

Note: Sample Splitting: The workmodes Load and Go and Scan and Load are 
made by the application specialist in the Application Settings Control.

EVOlyzer
Platform Only

Wash wait mode: To prevent the needles of the wash manifold from drying out for 
the time it is not used in a process, two different modes are available:

 Rinse soak in last wash buffer: The waste sink is filled with the wash buffer 
recently used, the manifold is lowered into it and left there until it is needed 
again by the process.
In this mode the washer will, after lowering the needles, rinse them for a 
configurable period of time (adjustable in durations.xml).

 No rise soak: No wash wait mode is used.

Maintenance: Select a maintenance configuration from the dropdownlist. This 
configuration contains the consumables needed for your maintenance procedure.
Profile: Select a maintenance profile. According to the profile, the placement of 
the consumables for the corresponding maintenance task will be affected.

 To save your changes, click the Apply button.
 To get back to the main menu, click Main menu.
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4.2.2 Barcode Types

On the Barcode types tab you can activate the used barcode types. For the 
barcode types Codabar and 2 of 5 Interleaved you have to define some additional 
settings (length, check digit mode, start/stop character). 
As the two barcode types Codabar and 2 of 5 Interleaved can cause problems 
because of their variable length, we strongly recommend to work with an 
evaluation. Whether the PosID should transmit this information back to the 
software can be selected freely.
For further information on the used possible barcode types, see also section 
“Positive Identification (PosID)” in the corresponding Operating Manual of the 
instrument.

To save your changes, click the Apply button.
To get back to the main menu click Main menu.

Fig. 4-31 Barcode types dialog box
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4.2.3 Paths

On the Paths tab you have to define the worklist folder, the output folder and the 
maintenance folder, i.e. where the worklist, the output and the maintenance 
reports are saved on your harddisk.
For this purpose click the button next to the corresponding field and select the 
path.
To save your changes, click the Apply button.
To get back to the main menu without saving, click Main menu.

Fig. 4-32 Paths dialog box
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4.2.4 Report Options

On the Report options tab you can define the folder for the report logo image, i.e. 
where the corresponding file is saved on your harddisk.
For this purpose, click the button next to the corresponding field and select the 
path.
In the field Report footer text you can enter the text to be printed in the footer of 
your reports. To add a page number to your report, write “%p” where you want the 
page number to be printed, see also Fig. 4-33,  4-35.
To save your changes, click the Apply button.
To get back to the main menu without saving, click Main menu.

Fig. 4-33 Report options dialog box
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4.2.5 Persistence Data

The Persistence tab contains settings which are used when a configuration uses 
persistent data.
Refer to the Freedom EVOlution SW Application Software Manual.
The Persistence path defines the folder in which all persistence data is stored, 
i.e. where the corresponding data is saved on your hard disk.

The Time Span allows you to define how long persistent data will be stored after 
creation. All data older than the defined time span is deleted at the beginning of 
Start of Day maintenance. 
When the check box is selected, the deletion of persistent data is overruled for 
consumables with the lot expiry date encoded in their barcode. These 
consumables will be deleted only when the lot has expired (and not after the 
defined Time Span).

To save your changes, click the Apply button.
To get back to the main menu without saving, click Main menu.

Fig. 4-34 Persistence data dialog box
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4.3 User Management

Note: This submenu is accessible to administrators only.

The User Management dialog box consists of two areas:
 The area User on the left-hand side, where the settings for a new user can be 

defined
 The user list on the right-hand side, where all defined users are listed with 

their User name, Full name and User group.

Fig. 4-35 User management dialog box
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4.3.1 Adding User

To add a new user, proceed as follows:

1 Click Add user.

The user name and the full name fields on the left-hand side are cleared.

2 Type in the user name in the first line. It must have between 5 and 10 
characters.

The user name will be used for logging in and authentication. It will appear on 
the header of each dialog box to indicate who is currently logged in.

3 Type in the full name in the second line.

4 Assign a user group to the user by clicking the arrow next to the selection field 
and highlighting the corresponding user group.

The user group will also appear in the header of each dialog box.

5 Click the Apply button.

The user is now added to the list on the right hand-side and enabled by 
default (the corresponding check box is checked).

Note: When a user is added, the initial password is automatically set equal to the 
user name. At the first login, users are prompted to change the initial password.

4.3.2 Disabling User

To disable a user, proceed as follows: 

1 Highlight the corresponding user in the list on the right-hand side

2 Clear the check box Enabled and click the Apply button.

Now the user cannot log in anymore.

Note: Users cannot be deleted.

To get back to the main menu click Main menu.
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5 Maintenance

Purpose of This
Chapter

This chapter explains how Freedom EVOlution SW supports the performance of 
instrument maintenance.

5.1 Menu Item Maintenance

The maintenance selection dialog box enables access to the three maintenance 
sequences:

Fig. 5-1 Maintenance selection dialog box
Freedom EVOlution SW Runtime Controller Manual, 394803, en, V2.3 5 - 1



5 - Maintenance
Menu Item Maintenance
The column subscribed with Date due indicates the dates when the individual 
maintenance sequences respectively have or had to be carried out.

Note: If the working day exceeds eight hours, the daily maintenance should be 
repeated before the instrument is restarted.

Note: The weekly maintenance should be performed on the last working day of 
each week.

Activate the corresponding option button and click the Next button to get to the 
desired submenu.

To abort the maintenance sequence and get back to the main menu, click Main 
menu.

Submenu Action

Daily Maintenance - Start of Day To carry out the maintenance task, which 
have to be done at the start of the day. If 
“(overdue)” is indicated behind the submenu, 
at least one maintenance task of this mainte-
nance sequence is overdue.

Daily Maintenance - End of Day To carry out the maintenance task, which 
have to be done at the end of the day. If 
“(overdue)” is indicated behind the submenu, 
at least one maintenance task of this mainte-
nance sequence is overdue.

Weekly Maintenance To carry out the weekly maintenance. If 
“(overdue)” is indicated behind the submenu, 
at least one maintenance task of this mainte-
nance sequence is overdue.
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5.1.1 Viewing Records

To view maintenance records, click View Records.

To view and print the selected maintenance record, click the Print button.

To return to the main menu, click Main menu.

Fig. 5-2 View maintenance records dialog box
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5.2 Maintenance Steps

General The maintenance part of the Freedom EVOlution Run Control is set up like a 
wizard. You are guided through the tasks supposed to be carried out step by step.
The dialog boxes that guide you through the maintenance tasks of the different 
sequences have a consistent structure. They consist of the following interactive 
elements:

Next button. In the context of the maintenance sequences the Next but-
ton has a slightly different meaning than in the other Run Control dialog 
boxes. By clicking on it you will get to the next step for the preparation or 
post-processing of a maintenance task, e.g. a flushing procedure.

Main menu button. By clicking this button you will abort the mainte-
nance sequence and get back to the main menu.

Done button. By clicking this button you indicate that the required main-
tenance step was carried out successfully and you will proceed with the 
next step.

Skip button. By clicking this button you miss out the currently required 
maintenance step and will get to the next one. The results of runs 
started afterwards without this maintenance step being carried out 
before will be flagged with a warning indicator.

Repeat button. By clicking this button you can repeat a procedure within 
a maintenance step, e.g. a flushing procedure.

Print button. By clicking this button you can print out a report, e.g. a 
maintenance report after the maintenance is complete.
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During a protracted instrument procedure, e.g. when the instrument is flushing, a 
dialog box with a progress bar is displayed, indicating the status of the 
corresponding procedure.
For details on how to carry out the maintenance tasks refer to the Operating 
Manual of the instrument.

5.2.1 Maintenance Dialog Boxes

The maintenance dialog boxes all have a heading, indicating e.g. the component 
to be maintained, a descriptive text, telling you the instrument status or how to 
proceed. Some also have an illustration of the corresponding component.

Fig. 5-3 Print preview of Daily/Weekly Maintenance
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Example of a
Maintenance

Task

To achieve specified performance and reliability of the instrument, carry out the 
maintenance tasks by clicking through the Freedom EVOlution Run Control and 
following the instructions on the screen. The tasks are sorted by the same order 
as indicated in section “Preventive Maintenance and Repairs” in the Operating 
Manual of the instrument.

Fig. 5-4  Liquid system dialog box 
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6 Utilities

Purpose of This
Chapter

This chapter gives information on separate software tools that can be used by the 
operator in the Freedom EVOlution SW environment.

6.1 Plate Manager (SW Version 2.0 Only)

The plate manager is a separate software tool for reporting purposes.

For each plate processed by the instrument, a plate report file is generated. This 
xml file contains all sample tracking information for the plate. With the Plate 
Manager, the plate report files can be viewed and printed out. The Plate Manager 
is configured to look into the Freedom EVOlution output folder for plate report 
files.

The main table contains a list of all converted plate report files. By double-clicking 
on a list item, or by selecting a list item and then clicking the View button, a Print 
Preview window is opened and the selected report is displayed. You can now 
choose to print the report.

Use the Browse button to locate plate report files which reside in other folders 
than the output folder. When a file has been selected, it is displayed in a print 
preview window. If the file found is a plate report xml file, it gets automatically 
converted and then displayed.

In order to print a report without viewing it, click the Print button.

To (re)send the results to the LIMS, click the (Re)send button.

Fig. 6-1 Plate Manager dialog box
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Note: If you wish to manually release results with this option please make sure 
that automatic transmit in the Application Settings Control is disabled.

By clicking the Refresh button, all plate report files generated since the Plate 
Manager was started, are automatically converted to HTML and then appear as 
items in the main table.

Note: The HTML report does not contain all information from the Magellan 
workspaces. For detailed Magellan data, refer to the corresponding Magellan 
workspace.

6.1.1 Plate Map

Click on the menu item Mode to switch to the Create Plate Map view.

Enter the plate barcode in the designated text field and the sample barcodes/ 
sample IDs in the respective well position.

Click the Save button to save the plate map file.

Note: The plate map files have the extension “.map” and are saved in the Output 
path by default.

Click the Load button to load, view and modify an existing plate map file.

Click the New button to reset all fields for new data entry.

Exit Worklist
Creator

To exit the Worklist Creator, select File > Exit.

Fig. 6-2 Plate Manager / Create Plate Map dialog box
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6.1.2 Process Report

Process reports ProcessReport.html are defined by the overall plate statuses fail 
or success. 

PlateFailCriteria The over all plate status PlateFailCriteria is determined by the following set of 
criteria (default setting):

– <FailOnQCFailInAnyRead>true</FailOnQCFailInAnyRead>
– <FailOnAnyProcessError>true</FailOnAnyProcessError>
– <FailOnSampleInError>false</FailOnSampleInError>
– <FailOnNonSampleInError>false</FailOnNonSampleInError>

Examples Failure in a sample (e.g. clot detection):

FailOnSampleInError set to true:
 Failed 

– The error in the cavity is passed on

FailOnSampleInError set to False:
 Passed

– The error in the cavity is not passed on.

E.g: Should only 1 error have occurred in a certain cavity, the rest of the plate 
could be passed on if required
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6.2 Report Center (SW Version 2.1)

6.2.1 Running an Application

The Report Center is a separate software tool for reporting purposes. For each 
plate processed by the instrument, a plate report file is generated. This xml file 
contains all sample tracking information for the plate. With the Report Center, the 
plate report files can be viewed and printed out.

Output/ Reports Report files saved to the output folder are displayed in the Reports list on the very 
left Fig. 6-3 “Report Center”,  6-4.

Note: Xml process reports from earlier software version are also supported.

Printing Clicking the direct print icon displays, prints and adds the report files directory.

Trigger Words Trigger words respectively strings have been defined for Predilution as well as 
ArchivePlates.
Incoming reports will be parsed by pre-defined triggers words and sorted into the 
appropriate Reports list.

Automatic
Archiving

Selecting the Archive Automatic from the drop down menu Archive moves all 
reports older than the defined space of time to the reports file directory.

Viewing Selecting a listed report entry opens a data view window in the Report Center.

Fig. 6-3 Report Center
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XSLT-Sheet Tecan provides three report layouts:
EVOlution_default, EVOlution_layout and EVOlution_table

Note: The information displayed in the report depends on the XSLT-sheet defined.

• The XSLT-sheet can be customized if required.

6.2.2 Settings

Click the menu item Edit Settings from the menu, or click on the icon in the tool 
bar, to open the settings dialog Report Center Settings.

Startup document
By default the Tecan web site is displayed. The startup document can be 
edited.

Groups

Editing Settings Edit the settings appropriatley and close the dialog box.

Note: Settings not changeable are grayed out.

Fig. 6-4 Report Center Settings

Groups E.g. entries Designation

Group_A_Folder
Group_B_Folder

ArchivePlates
PredilutionPlates

Name of folder where report files 
will be stored

Group_A_Name
Group_B_Name

ArchivePlates
PredilutionPlates

Name of title displayed in the tab

Group_A_Trigger
Group_B_Trigger Predilution

Trigger words to determine 
reports for this specific tab (e.g. 
PredilutionPlates). The trigger 
words have to be separated by a 
comma, semicolon or a blanks. 

Group_A_Converter
Group_B_Converter

EvolutionReport_Table.xsl
EvolutionReport_Layout.xsl

Name of the XSLT file used to 
perform the transformation for 
reports from XML to HTML
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6.3 Worklist Creator

When you are not working with an LIMS, the Worklist Creator enables the easy 
creation of worklist files in xml-format for the Freedom EVOlution SW.
Open the Worklist Creator. The main menu is displayed, consisting of a test list at 
the right and a list of sample barcodes with the tests assigned to them on the left-
hand side.

To add a new sample to the list on the right, click on an empty cell in the Barcode 
column and enter the barcode of the corresponding sample. Then press Enter. 
The cursor will jump to the cell below.
To add a test to the created sample in the list, click on the cell in the Tests column 
next to it and activate the check box in front of the test(s) in the test list on the left 
you want to assign. You can also select more than one cell in the Tests column.
To remove a sample from the Barcode column, highlight it and press the Delete 
key on your keyboard.

Fig. 6-5 Worklist Creator
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6.3.1 File Menu

To load a saved worklist from your harddisk to the Worklist Creator, select File > 
Load ... or click the corresponding icon.

Note: A csv-file to be loaded as worklist into the Worklist Creator should have the 
format “Barcode; Test”.

To save the settings defined in the list on the right, select File > Save ... or click 
the corresponding icon.
To remove all settings defined in the list on the right, select File > Clear or click 
the corresponding icon. 

ATTENTION

The clear function cannot be undone. When it is used all unsaved data from the 
list on the right are lost.

6.3.2 Plate Map Modus

Click on the menu item Mode to switch to the Create Plate Map view.

Enter the plate barcode in the designated text field and the sample barcodes/ 
sample IDs in the respective well position.

Click the Save button to save the plate map file.

Note: The plate map files have the extension “.map” and are saved in the Output 
path by default.

Click the Load button to load, view and modify an existing plate map file.

Click the New button to reset all fields for new data entry.

Fig. 6-6 Worklist Creator / Create Plate Map dialog box
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Exit Worklist
Creator

To exit the Worklist Creator, select File > Exit.

6.3.3 Edit Menu

To create a range of samples, select Edit > Add Range. A dialog box opens:

In the text field on the left, enter the first and the last barcode of the range you 
want to create. Both barcodes should contain the sample prefix and a number at 
the end, which can be incremented. Click the Create button to append the sample 
range to Barcode column in the main window or the Cancel button to close the 
dialog box without creating a list.
To edit the tests currently available in the test list on the left, select Edit > Edit 
Tests.... The test names are displayed in the list on the right and can be modified 
or cleared by means of the Clear icon. To save your changes, select Edit > 
Commit Tests....
The test names are saved to the file Tests.config.

Note: Do not use question marks or the slash character in test names.

6.3.4 Help Menu

To open the Worklist Creator Online Help, select Help > Using Help.
To open the About dialog box of the Worklist Creator for getting information on the 
currently used version, select Help > About.

Fig. 6-7 Add Range dialog box
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6.3.5 Icon Bar

Open icon: By clicking this icon, an Open dialog box appears, enabling you to 
open formatted files, e.g. xml- and csv-files used as worklists. Select the file you 
want to open and click Open. It will then be loaded in the Worklist Creator.

Save icon: By clicking this icon, the worklist, currently displayed in the main win-
dow can be saved as xml-file to the Worklist folder within the Freedom EVOlution 
directory.

Add range icon: By clicking this icon, the Add Range dialog box appears, see 
6.3.3 “Edit Menu”,  6-8.

Clear icon: By clicking this icon, the settings for the worklist currently displayed in 
the main window are reset.

Help icon: By clicking this icon, the online help for the Worklist Creator is opened.
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7 Error Handling

Purpose of This
Chapter

This chapter describes error messages that can be issued by the software. It 
gives information on the cause of the error and instructs how to correct the error, 
where applicable.

7.1 Error Messages 1

The following table lists error messages for which the software provides 
instructions on recovery, etc.:

Tab. 7-1 Error messages 1

Instrument Part / 
Function Error message

Problem description/
Actual situation

Expectation/
Recovery

Base unit Door lock The door locks could not 
lock properly when trying to 
lock the front safety panel.

Make sure that the front safety panel 
is closed.
Retry to lock the front safety panel 
and then proceed as usual.

PosID Verification scan error Found component with bar-
code.

Didn’t expect a component. The 
position was not controlled by the 
reload.

PosID Verification scan error Found carrier with barcode. Expected situation: Empty (no car-
rier on the grid position).

PosID Verification scan error Found component with bar-
code.

Expected situation: Expected com-
ponent without barcode.

PosID Scan error Found duplicated compo-
nent.

Ignore the error or access the work-
table and fix the problem.

PosID Sample scan error Carrier not present. Place carrier in proper position.

PosID Plate Barcode scan error No barcode found Place plate with barcode in proper 
position or enter barcode manually
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7.2 Error Messages 2

The following table lists error messages for which the software itselft does not 
provide instructions on recovery:

Tab. 7-2 Error messages 2 

Part / Function Error message Problem description Recovery / Comment

Application set-
tings

At least one test must be 
selected.

The user is in the 
Application Settings on 
the tab Main Settings. 
Batch mode and a configu-
ration is selected, but no 
test.

Please select at least one test.

Application set-
tings (PosID)

Codabar 1 and Codabar 2 
cannot have the same 
length if they are both 
active.

Incorrect definition of the 
permissible barcodes of 
type “Codabar” in the Appli-
cation Settings.

Select only one item for the barcode 
type “Codabar” or specify different 
lengths for several items of the same 
barcode type.

Application set-
tings (PosID)

2 Of 5 Interleaved 1 and 2 
Of 5 Interleaved 2 cannot 
have the same length if 
they are both active.

Incorrect definition of the 
permissible barcodes of 
type “2 Of 5 Interleaved” in 
the Application Settings.

Select only one item for the barcode 
type “2 Of 5 Interleaved” or specify 
different lengths for several items of 
the same barcode type.

Authentication Authentication failed. User 
name or password was 
incorrect. Try again.

Error when trying to log in. Enter the correct user account data.

Authentication Your password has expired. 
You will be prompted to 
change password.

The system recognizes a 
new user, who must change 
her / his initial password.
Or: The old password has 
expired.

User needs to change the password.

Authentication You are not authorized to 
perform the selected action.

During authentication the 
system recognized that the 
user hasn’t got the neces-
sary access rights.

Either a different user with the corre-
sponding access rights must log in 
or the user needs to contact the sys-
tem administrator.

Authentication Your initial password has 
expired. Please contact 
your administrator.

The password has expired. 
The administrator needs to 
issue a new one.

Contact the system administrator 
and request a new password.

Authentication Your user account has 
been disabled. Please con-
tact your administrator

The user was disabled 
because she / he tried to 
log in several times.
The administrator needs to 
reset the authorization.

Contact the system administrator for 
resetting the authorization.

Authentication User does not exist. Try 
again.

User not known. Enter correct user name or have a 
user created.

Authentication You have entered the 
wrong password. Try again.

The password was not 
entered correctly.

Enter correct password.

LiHa Clot detected During aspiration a clot was 
detected.

Remove the clot from the corre-
sponding tip.
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LiHa No Diti Found Partially filled DiTi boxes 
loaded

Select Fetch Diti at Position x and 
enter next DiTi as number.

LiHa Tip collided Detected a crash while 
aspirating, affected tips: x

Access instrument and remove the 
disturbing object and continue.

Manual entry of 
barcode values

The two entered barcodes 
were unequal or one of 
them was empty. The bar-
codes must be equal and 
cannot be empty.

Erroneous barcode value 
entry.

Enter correct barcode values.

Manual entry of 
barcode values

This barcode has already 
been entered for another 
sample.

A barcode value that 
already exists was entered.

Enter / use a different barcode.

New password User name, full name or 
password was blank. Try 
again.

Error when trying to change 
the password.

Enter user name, full name and 
password in the corresponding field.

New password Password, new password 
or confirm new password 
was blank. Try again.

Error when trying to change 
the password.

Enter passwords in the correspond-
ing fields.
(This error will be logged).

New password Confirmation of new pass-
word did not succeed. Try 
again.

Password and password 
confirmation do not match.

Confirm with the correct password.

New password Password change failed. 
Try again.

Error when trying to change 
the password.

The following conditions must be 
met to successfully change the 
password:
• The user exists
• The user name must have a length 

of 5 to 10 characters
• The password must have a length 

of 5 to 10 characters

New password Only numeric and alpha-
betic characters are 
allowed. Try again.

Error when entering a new 
password.

Password must consist of numeric 
and alphabetic characters only.

Process The configuration could not 
be activated. Unexpected 
files have probably been 
found in the configurations 
directory.

The files of the configura-
tion are inconsistent.

Open the configuration builder and 
check the contents of the configura-
tion.

Process Handling of error is not pos-
sible because scheduling is 
complete.

The schedule is already 
completed, i.e. the error 
occurred at the very end of 
the process.

Error during execution of a process.

Process The process was not 
patched during error han-
dling because it was too 
late to take effect.

The internal error handling 
could not take effect.

Error during execution of a process.

Tab. 7-2 Error messages 2  (cont.)

Part / Function Error message Problem description Recovery / Comment
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Process A timing constraint was vio-
lated. The affected micro-
plate will be moved back to 
the shelf either immedi-
ately or after execution of 
the actions defined. See log 
file for details.

A timing constraint was vio-
lated and the system was 
able to modify the process 
in such a way that the plate 
is transferred directly to its 
destination.

Timing constraint violated. Only 
active if constraint violations are 
handled as error.
This setting is made by the applica-
tion specialist in the Application Set-
tings Control.

Process No work orders were found 
for samples from the last 
sample scan.

Empty work list or work list 
for wrong configuration 
found. All assays at consis-
tency check during initial-
ization removed.

Work list does not contain any tests 
that can be run at the time.

Process Scheduling will fail because 
process '{0}' consumes 
more '{1}' than can be 
loaded onto the worktable. 
Try again with less sam-
ples?

The process consumes a 
greater amount of a con-
sumable than can be 
loaded onto the worktable.
Example: Parallel sample 
pipetting (including diluent, 
controls) may consume an 
extremely high number of 
DiTis. These need to be 
loaded onto the worktable 
before this step.

Process consumes too much of a 
consumable. Reduce number of 
samples.

Process Process '{0}' will not be 
executed because it con-
sumes more '{1}' than can 
be loaded onto the workta-
ble. Too many samples?

The process consumes a 
greater amount of a con-
sumable than can be 
loaded onto the worktable.
Example: Parallel sample 
pipetting (including diluent, 
controls) may consume an 
extremely high number of 
DiTis. These need to be 
loaded onto the worktable 
before this step.

Process consumes too much of a 
consumable. Reduce number of 
samples.

Process The shelftime of the con-
sumable '{0}' must not 
exceed the limit (see Con-
sumable Editor).

Shelf time exceeded. Object remains too long on the work-
table.

RoMa An error occurred during 
ROMA transfer. Probably 
the plate could not be 
fetched or was not found 
where expected.

The RoMa tried to transport 
a plate which is not being 
transferred for the first time 
in the process (e.g. from 
the shelf).
The system will be stopped.

The RoMa could not transport the 
plate
• No plate present
• A crash occurred
• Plate could not be placed

RoMa Plate could not be fetched 
in shelf or site was empty.

The RoMa tried to transport 
a plate which is being trans-
ferred for the first time in 
the process (e.g. from the 
shelf).

The RoMa could not transport the 
plate
• No plate present
• A crash occurred
• Plate could not be placed

Tab. 7-2 Error messages 2  (cont.)
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User management The user name must have 
5 or more characters.

User name defined in user 
management is too short.

Enter appropriate user name.

User management User could not be created. 
User name must consist of 
minimum five, maximum 36 
alphanumerical characters.

User name could not be 
stored.

Correct the entries.

User management Username syntax is incor-
rect.

User name could not be 
stored.

Correct the entries.

User management The user already exists. User name could not be 
stored.

Correct the entries.

Tab. 7-2 Error messages 2  (cont.)
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